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About This Particular Macintosh has been free since 1995, and we intend to keep it that
way. Our editors and staff are volunteers with real jobs who believe in the Macintosh way
of computing. We don’t make a profit, nor do we plan to. Our aim is to produce a fiercely
independent magazine, with multiple formats designed for easy reading rather than showing
ads. The views expressed in these pages have always been our own, and to help prove it we
do not accept direct sponsorships or advertising. We do, however, need to pay for our Web
site and other expenses, so we rely on minimal advertising, sold indirectly via Google and
Yahoo, as well as the support of ATPM readers who shop at Amazon.com using our link.
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Welcome

by Robert Paul Leitao, rleitao@atpm.com

Welcome to the November issue of About This Particular Macintosh! Last month, Apple
began a new era in the company’s storied and illustrious history with the passing of Steve
Jobs.

The mission of ATPM is to celebrate what we call the “personal computing experience.”
There is no one else on the planet who made computing more personal, computing devices
so intuitive to use, or the many uses something to celebrate as Apple co-founder Steve Jobs.
The editors of ATPM mourn his loss.

The Steve Jobs Biography Is Available Through iTunes

Walter [saacson’s authorized biography of Steve Jobs was released for distribution on Octo-
ber 24th and will quickly find its way to the top of the bestseller lists. The book is available
through iTunes and the Apple iBookstore.

There’s something that’s thematically consistent about reading this biography on one of
the Apple devices that Steve Jobs brought to the global marketplace. We wish you good
reading about an extraordinary man who did extraordinary things and changed the world
around us in extraordinary ways.

The iPhone 4S

In October, Apple release the fifth iteration of the iPhone. The new iPhone runs iOS 5 and
is powered by Apple’s A5 chip. It’s called the iPhone 4S. The moniker is due to the new
phone’s use of the original iPhone 4’s form factor and display. But much about the new
phone, including the Siri assistant, the dual-core chip, and the eight-megapixel camera that
will capture HD video, separates the iPhone 4S from its immediate predecessor. Typical
to iPhone product refreshes, lines formed early outside the company’s retail stores as eager
customers waited patiently to purchase the new smartphone handset.

The release of the iPhone 4S in early October and following the close of the company’s fiscal
year in late September resulted in a dramatic slowing of Apple’s rate of revenue growth in
the September quarter. No matter the name given to a new Apple device, it’s the newness
of the company’s products and the continuing product innovations that drive unit sales.

iOS 5

Concurrent with the release of the iPhone 4S, Apple released iOS 5, the latest version of
the company’s operating system for the iPhone, iPad, and iPod touch. The new operating
systems boasts a number of new product features and fully integrates iCloud services into
the user experience. It’s a free upgrade for legacy device owners, and the advancements
delivered in the new version of iOS enhance the use of devices that meet the upgrade
requirements.
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Moving Forward

The editors of ATPM chronicled the return of Steve Jobs to the helm at Apple, and we
will continue to chronicle the success of the company he co-founded in a Silicon Valley
residential garage. We will miss him in the months and years ahead.

To those of us who closely follow Apple, Tim Cook is a familiar name and a familiar voice
on the conference call each quarter with Wall Street analysts. Mr. Cook is regarded as one
of the most competent executives in industrial America today, and we look forward to the
many new products to be released during his tenure as the CEO of Apple.

Our November issue includes:

MacMuser: Death of a Salesman
“Steve Jobs. . .transformed my life in so many ways that I just can’t express my gratitude. ..”

MacMuser: Life Can Be So Cruel

Mark Tennent muses on mobile phone contract options as his newly ordered iPhone is
delivered to a location out of his reach for several weeks.

PEBKAC: On the Passing of Steve Jobs

Chris Turner ruminates on the passing of Steve Jobs.

On a Clear Day: Without Him, You Wouldn’t Be Reading This

Mike Shields shares what led to his reverence of Steve Jobs.

Apple Talk: Great Job

Three stories about computers, users, and connections.

Segments: Reflecting on the Green Screen Experience

Dave Trautman throws back to the time when typing was the most useful thing a person
could do with a computer.

Desktop Pictures: The Netherlands
Reader Henk-Jan Osse shares photos from The Netherlands (Holland).

Out at Five

Matt Johnson’s new series, Out at Five, looks at the workplace and its boundaries from all
angles, revolving around many of the same characters from his former series, Cortland.

Qaptain Qwerty
An apple a day?
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The Spinning Beachball
Thank you, Steve.

Review: Comic Life 2.0.6

I dream of Comic Life 2.

Review: Memoir 2.0

An easy-to-use, inexpensive journaling utility, useful for recording ideas, impressions, and
rough drafts.

Copyright © 2011 Robert Paul Leitao. Robert Paul Leitao is a contributing editor at ATPM and is
author of the Posts At Eventide and The iPad Chronicles blogs.
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How To: Make the Most of TextEdit

I like TextEdit. I use it for ideas. It is quick to open. I have nothing to set up before typing.
If T want to save a poem or something I've composed on Facebook, or chat, I just copy and
paste it on TextEdit, pictures and all. It has enough features for me to get the complete
idea written down. I can rewrite the idea, and save. I can copy and paste into Pages if I
decide to expand on that idea. It is a great little program to save sticky note ideas. I can
file them and open to use any time. I hope they never take it off Mac computers. The only
problem is if it is a large idea. It will squash everything on one page, if I decide to print.
Sometimes it will be less that # 7 size print.

—Heather Isaacson

To prevent TextEdit from trying to squeeze the entire window width into the page width,
go to the Format menu and choose “Wrap to Page."”
—NMichael Tsai

We'd love to hear your thoughts about our publication. We always welcome your comments, criticisms,
suggestions, and praise. Or, if you have an opinion or announcement about the Macintosh platform
in general, that's OK too. Send your e-mail to editor@atpm.com. All mail becomes the property of

ATPM and may be edited for publication.
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MacMuser

by Mark Tennent, http://www.tennent.co.uk

Death of a Salesman

After hearing the news of the death of Steve Jobs, my first reaction was of sadness for
him and his family. But later, it became more than sadness as the news of his death was
repeatedly broadcast by the media. That dull feeling in one’s stomach, tight throat and
itchy eyes.

In the 1980s Steve told John Sculley, president of Pepsi, that he could sell sugared water
but if he joined Apple he could change the world. Prophetic words and ones I listened to
as well. In those days and stuck in a career I hated, Apple’s computers offered an escape
route.

The competition then had green-and-black screens, were driven by command lines, and
beeped; while Apple’s computers were in colour, operated by a mouse, and talked to you
in stereo. Macs opened the door into desktop publishing, something I had a toehold in via
the old Amstrad PCW and Atari ST. It meant spending as much as a brand new car for a
Mac, laser printer, and software, but my design and publishing business flourished, keeping
me in work for over 20 years until the bankers screwed the world.

Now, I am typing this on my Mac Pro (albeit logged in from a PC 10 miles away), make
calls on my iPhone, listen to my iPod, and take an iPad and MacBook on holiday. Tonight
we shall probably watch something on our Apple TV.

Steve Jobs and all the people at Apple transformed my life in so many ways that I just
can’t express my gratitude and how much I owe the company and its visionary leader, Steve
Jobs.

Copyright © 2011 Mark Tennent.
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MacMuser

by Mark Tennent, http://www.tennent.co.uk

Life Can Be So Cruel

iPhone Friday saw me at O2 checking out the new phones, and very nice they are, too. But
where to get the best deals?

There are many comparison sites on the Net, including an excellent one at Yahoo Finance
listing most of the deals. Their total cost of ownership is over 800 pounds for 24 months,
but you are tied to one operator. One of my niggles is that I can’t use data when on holiday
abroad. With an unlocked phone I can slip in a cheap foreign sim to take advantage of the
local rates.

In the past six months I've used 60 minutes of talk time, 10MB of data, and 20 texts. As
a broadband customer, Virgin has a deal for me at a penny under eleven pounds, offering
a rolling monthly contract with 200 minutes, a gigabyte of data, and 5,000 text messages.
How the hell you can use so many texts is beyond me. That’s writing a message every
8 seconds not including talking for 200 minutes and using the 3,000 minutes calling other
Virgin Mobil customers. I suspect my daughter could use it all as she is polishing her finger
nails.

The up-front cost of the Virgin deal is to buy an unlocked iPhone from Apple and getting
Virgin’s standard sized SIM cut-down to a micro-SIM. That’s a pound in the local shop or
buy a SIM-cutter online for less than a fiver. Then, in two years’ time when the iPhone 5S
is released, I'll sell my iPhone 4S for over a hundred pounds and get the next one.

Scattered around our studio we have various cell phones dating back to the 1990s. Most
still work if we can find a charger, but apart from a tiny Samsung circa 2000, a personal
favourite, they are all virtually worthless. I've already got a buyer for my iPhone 3GS.

Then I found Giffgaff, who looks very cheap, as in low cost, but there is still the feeling
of “cheapness”. They are an O2 virtual provider, buying time wholesale and reselling it.
Coverage will be good here and abroad, but they only have 16 paid staff and rely on their
own customers to provide support.

In theory this sounds a good way to keep costs down, but in practice it means asking ques-
tions on an Internet forum and then sifting through the oh-so-helpful responses. Personally
I prefer to ring “Sandy” in Mumbai and get an immediate answer. It’s also a hassle to
keep buying PAYG top-ups and data bundles, or Goodie Bags as they call it. Currently
there isn’t an automatic way to buy them. I'd be happy to pay a pound or so extra to have
Giffgaff on a contract-style basis. Perhaps it’s too cheap for me?
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Tesco mobile seems the lowest cost if I want to pay for another expensive monthly deal (no
thanks), but for 24 months the TCO is still over 800 pounds. Unfortunately, their SIM-only
deal is one of the more expensive even though, like Giffgaff, they are an O2 virtual supplier.

My next phone will be an iPhone, unless hell freezes over and I have switched to Linux or
(shudder) Windows. T feel dirty just thinking about that last one. Anyway, it’s ordered
now and due to arrive while I'm lying in a hospital bed for a couple of weeks, having my
every whim pandered to by nubile nurses. Meanwhile, my new phone will sit unopened and
unloved. Life can be so cruel.

Copyright © 2011 Mark Tennent.

)
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PEBKAC

by Christopher Turner, cturner@atpm.com

On the Passing of Steve Jobs

In 1996, I was working for The Computer Shoppe, in Metairie, Louisiana. The Computer
Shoppe is distinctive in that it was one of the original Apple retailers signed up nearly
20 years before. That year, Apple Computer, Inc. celebrated its 20th anniversary, and
there was much hullabaloo. One such bit of hullabaloo was the visit by Apple bigwigs and
Steve Wozniak to our humble shop. Then—Apple CEO Gil Amelio had enlisted Woz, as one
of the company’s original founders, to act as the face of the company for the anniversary
goings-on.

Woz spent an entire day at the store, and the entire staff got to go to a dinner that night,
where The Computer Shoppe’s owners were presented with a crystal apple as thanks from
the company. Some time during that day, I got Woz’s signature on the mostly-blank side
of one of The Computer Shoppe’s tri-fold flyers.

I've attended two Macworld Expo keynotes where Steve Jobs was presenting. The first time
[ was in the same (albeit very large) room as Jobs, I thought about that flyer with Woz’s
signature, and how neat it would be to get both founders’ autographs together.

These were the heady days of two Macworld Expos a year, and I knew I'd be attending the
very next Expo, so for that time, I dug through the box of momentos and found the flyer.
It was with me in the keynote hall, and it was in my hand as I got within about 15 feet of
Jobs after the keynote had concluded and the hall had mostly emptied.

That flyer still bears only Woz’s signature.

I don’t remember who Jobs was talking to. It didn’t appear to me it was a media-related
conversation, and my memory isn’t deep enough to recall whose badges said what, so it
very well could have been a less-publicly known Apple executive. Or just a friend.

What I do recall is that Jobs appeared at ease. Comfortable. He wasn’t having to be “on”
for the keynote presentation. He was more relaxed now. There were a few other people
were milling about, waiting for a chance to talk to Steve, shake his hand, whatever. 1
looked around at them, and the thought occurred to me, This just doesn’t feel right. 1
cannot recall there being anything specific triggering that thought, but I do remember the
thought. This just doesn’t feel right. So I stuck the flyer back in my laptop bag and headed
out, no looking back, no regrets.

There may have been a time to ask Jobs to sign the flyer, to get his John Hancock next
to his former partner’s. But that wasn’t it. Not when he was coming down from arguably
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some of the toughest in-the-public-eye work he did each year. It was time to let him bask
in the finish, to relax, to enjoy.

Many words have been and will continue to be spilled about the life of Steve Jobs. He’s
been called many things: visionary, leader, driven, egotistical, asshole. He will be remem-
bered fondly by many. He will be remembered foully by some. Love or hate, he will be
remembered.

The first computer my family owned was a used Apple |[e, purchased from a teacher at my
high school. T distinctly remember going with my dad to the teacher’s house to pick up
the system, and I distinctly remember seeing my first Macintosh in person, for that was
what had replaced the |[e for this particular teacher. I remember buying my first Mac in
the Tulane University book store while my wife was in law school. And I remember going
into the Dallas metroplex’s first Apple retail store to buy the first iPod.

Like many of my friends, I would not have had many of the experiences, the jobs, I have
had were it not for two Steves getting together to build a personal computer. Which led to
another. Which led to another. And another. And so on.

What we should remember most about Steve Jobs, for all that he accomplished, is that,
in the end, he’s just a man. A man with family and friends who loved him deeply, and
who will mourn his passing more deeply than any one of us outside that circle. For me,
tomorrow is just another day in my life. For them, tomorrow is another day without the
dear one they loved.

So I do not mourn Steve Jobs for myself, despite what his life’s work meant to mine. Instead
I mourn for his family, who now face life without a husband and father.

And for the rest of us, tomorrow will be just another day. Tomorrow, there is no chance of
Steve returning. Tomorrow, there is no amount of mourning and what-iffing that will bring

him back.

Tomorrow is the time to turn to the ideals Steve believed in: striving for perfection, though
it is never attained; demand the best in yourself, and strive to bring it out in others; and
to live your life to the fullest in pursuit of your dreams.

Copyright © 2011 Christopher Turner, cturner@atpm.com.
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On a Clear Day, You Can See the Hollywood Sign

by Mike Shields, mshields@atpm.com

Without Him, You Wouldn’t Be Reading
This

When I heard the news, I asked Michael if we’d be getting out a special issue immediately,
however, he stated that we're posting our memories here, as part of the regular monthly
issue. Having had some time to think about what Steve Jobs’ legacy has meant to me,
words have failed.

What I can tell you about is my personal experience with the Mac, that ultimately has led
to my reverence of Steve Jobs. As you all know, he and Steve Wozniak created the Apple
computer over 35 years ago. The specific year was 1976, and about a year before that, I
decided I wanted to dedicate my life to telling machines what to do. At the ripe old age of
15. Little did I know what I had gotten myself into.

Mostly mainframes, as it turned out. Dumb terminals connected to the beginnings of the
'net that Al Gore didn’t invent as I majored in Computer Science during my college years
at USC. Back then, they didn’t have the term information systems. That came later. 1
hadn’t really heard about desktop computers until '83, when I got a job at what was then
Hughes Aircraft, as I may have related on this site previously.

I believe it was an IBM XT, running DOS. Seven months later, I'm sitting at a Super Bowl
party watching the then LA Raiders stomping on the Washington Redskins, and am witness
to “1984.” All the research I've done lately suggests that I've seen this commercial only the
one time, however, I specifically remember seeing it after that date on TV at my home in
North Hollywood. Enough to check out the computer in question, at least.

Remember when Macs cost a lot? I seem to recall prices upwards of $5,000 when I first
priced out the early Macs. The first one I remember using is an SE/30 that my friend
had. Was good for playing games like early versions of EA Football and the like. Played a
couple of text-based games with enhanced graphics, too. The visual element added to the
experience.

Meanwhile, at work, I was still connected to a dumb terminal that linked to the network
at Hughes. Was given control of a project that required that I learn C. So, I bought a
book, and did that in a day. Eventually moved into a department that was using an Apollo
network, and started programming on that. Almost ten years later, I find out that Apple
absorbed Apollo. Got laid off from Hughes the first time in September of '86.

I’'m Not an Actor, But | Play One on TV
It was at this point in my life that I made a monumentous decision that ultimately brought
me to you today. As I was unable to get work in my chosen field, and being the son of
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parents who both had Theatre Arts degrees, I pursued an acting career. I probably should
have done this earlier, however, this is why not too many people know that I'm famous.
Spent five and half years in radio, all the while attempting to save for a Mac that was
painfully out of reach. After getting laid off from radio, I got a job with a production
company, where I was handed complete control of yet another SE/30 that held most if not
all of the company records. This led to a job selling computers in Burbank, and receiving
copies of MacWEEK, wherein I learned about Jobs’ firing.

Most of the people that came into the store looking to buy were in the entertainment
industry that I was on the periphery of, and their computer of choice was a Mac. They had
probably just seen “Jurassic Park,” and the Quadra 700s. I got educated in an early version
of Final Draft during my time there, too. It was from there that I got to know enough
about the Mac to become a desktop technician for my second stop at Hughes Aircraft, and
led me to my computer of choice, as well.

While I was away, they went to the distributed desktop model, wherein everyone had a
PC or Mac on their desk, and there were about 15 of us that had to maintain over 2,000
computers that the various engineers were using. As a Mac Tech, there’s a lot of time to sit
around, as they simply work, as you know. That’s how I found ATPM, on one of my random
searches of the early Web. It was also during this time that I expanded from merely being
an actor, into a writer and a director. Producer would come a bit later, when I realized
that no one was going to hire me, or buy my scripts.

For whatever reason, there was an anti-Mac bias there, and I've written about that in the
past. From what I specifically remember, several news organizations predicted the demise
of the Apple computer itself. It was about this time that Jobs came back as iCEO. A title
he jokingly claimed during the keynote speech at Macworld Expo in 2000. I had the honor
of seeing this online on my Mac G3 I was using at JPL as a Mac Tech there. It was at this
point that he announced what would become the .Mac accounts, and I grabbed one right
away.

RIP Steve

So here we are, over ten years later, never to see him take command onstage again, announc-
ing the latest and greatest to come out of Cupertino. He leaves behind a powerful legacy,
and he’ll be a tough act to follow. I'll never really know what it was like to experience him
live, however, what he has brought to me, and ultimately you, my three readers, will last
forever.

Copyright © 2011 Mike Shields, mshields@atpm.com. Mike is working on his 168 project.
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Apple Talk

by Angus Wong, http://www.anguswong.net

Great Job

Let’s look at three stories today.
No big deal. Just three stories.
The first story is that of the personal computer.

Not to diminish the many contributions from others, but it’s entirely possible to imagine
that, without Steve Jobs, “personal computers” might never have entered the mainstream.
HP dismissed the idea outright, and IBM took a relative eternity to participate after seeing
the promise in the market that Jobs helped create with the Apple I and Apple II. Without
personal computers, the Internet as we know it might be unrecognizably restricted to soldiers
and scholars, and who knows what inspiration Tim Berners-Lee might have lacked had he
not been working on a NeXT machine at CERN.

The second story is about users.

Like Prometheus, Steve Jobs brought technology to the great unwashed masses, to “the
rest of us.” Freeing great ideas from incubation in ivory towers and the unlit dens of
hobbyists alike, Jobs was the harbinger of the future. Graphical user interfaces, USB,
wireless connectivity, user-generated HD content, touchscreens, app stores. He brought to
the wider world leading edge innovations in almost every iteration of Apple’s products. And
he did so objectively, with certitude, via transitions that were made with a firm gaze fixed
on our shared future, not with a hesitant eye glancing backward to compatibility.

The third story is about connections.

Steve Jobs connected us. He gave disparate people a common language of movement and
motion. Geeks and gurus. Techies and typographers. He fused together the sheer power
of raw computation with entrancing beauty, forming a team that produces images that
bring joy to children, while reminding adults of the big picture. He transformed how we
experience music, movies, and books, and how we keep in touch as we roam through a
hungry, foolish world.

I reminisce about more than three decades of using technologies gestated by Steve Jobs as
I type this article in Pages, on my MacBook Pro, on my birthday. It has been a grand,
electrifying road trip, but now we’ve lost one of our key drivers.

Where were you when you heard the news? For me, it was a beautiful day in Hawaii, a
place Jobs enjoyed visiting. The sun was bright, and the clouds were light. It was strange
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to be told that something was amiss in the universe, and yet, like millions of others, I first
received word of his passing via a news alert on my iPad.

Jobs might be amused to know that, even in his passing on, he generated tremendous good-
will and awareness for Apple. And, maybe underscoring the point of his Stanford speech
just a tiny bit more, he has skated to where the puck ultimately will be for all of us.

I came across this unaired version of Apple’s Here’s to the Crazy Ones ad, narrated by
Jobs, which unwittingly eulogizes him in the kind of poignant, poetic way he probably
would have initially hated, but ultimately approved of. “Because the people who are crazy
enough to think they can change the world. . .are the ones who do.”

Glorify or vilify him, Steve Jobs was, and always will be, obviously and irreplaceably,
insanely great.

Copyright © 2011 Angus Wong. After varying roles in the technology industry, Angus Wong is now
a freelance technical writer and marketing consultant. For occasional offbeat industry commentary,

follow him at http://twitter.com/anguswong.
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Segments: Slices from the Macintosh Life

by Dave Trautman, dave.trautman@shaw.ca

Reflecting on the Green Screen Experi-
ence

Before a computer could search the world for a piece of video (and well before people
were providing profile updates on a minute-to-minute basis) the screen and the text were
the most significant thing a computer could accomplish. There were drawing machines and
calculating machines and printing machines, but the most useful of them all was the writing
machine.

Can you not say the majority of what we link to in a browser is the text? Even the sites
which feature audio, video, and images require text and more text to provide con-text.

These are the thoughts. These are the ideas. This is what the World Wide Web was
designed to do: share ideas and compile everyone’s thoughts. It was intended to allow
people to annotate their writing with links to other writing and to reference other people’s
thoughts with a hybrid document, allowing a simultaneous experience of both the flow of the
author’s thoughts along with the derivation of their thinking from other authors’ thoughts.

I was first asked to use a personal computer in my workplace, which required me to learn
a lot of related things before I was able to settle down and write with it. I had to learn
to load floppy disks, format them, create directories, open and save documents to these
disks, and make copies and backups of these disks. I also had to learn an arcane method of
formatting text into a print output. I had to learn how to launch a writing program and to
store my progress on removable media. But the most significant thing I had to learn about
using a computer to write with was allowing the text to “wrap” from the right margin back
to the left. I had to stop using the Return key.

As someone schooled in both manual and electric typewriting, and who was quite adept
with both, I had been indoctrinated to the pattern and rhythm of typewriter keys, rollers,
and return swipes. With electric typing, the Return key is quickly your friend and allows
a meaningful speed-up of your writing. It was a long first two weeks until I habituated to
this new writing machine.

I was eventually able to write a variety of documents on this new machine. I did some
reports once I mastered the coda of emphasis, spacing, margins, and tabs. I also was able
to benefit from the automated format “macro” available through a script-writing program.
I marveled at the predictability of the macro, which knew what my script format required
at each step. I very quickly invested time and energy into learning every function and
feature of that scripting program. Script writing, for those who have never tried it, has a
particularly arcane set of rules within a narrow set of document specifications. It cannot
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be compared with such things as APA Style or Chicago Style rules. Yes, there are many
style rules in those guides, but for a proper and permitted screenplay, the rules for writing
them are nothing less than ruthless. At least at the time I was using the same particular
script-writing program they were.

The other perceptual shift I had to make was related to the “endless roll” of virtual paper on
which a person could write without end. Electronic document writing allowed me a limitless
vista of length and no need to insert paper or line up carbon layers. This virtual writing
reality immersed me immediately into the possibilities of non-stop pagination, continual
and uninterrupted stream of conscious composition, and the satisfaction of instant reprints
and copies.

By the time I was seriously involved with this new keyboard-based interface, I was at-
tempting to cram the key combination codes, for cutting and pasting and sophisticated
formatting, into my already stuffed brain. This new textual and tactile world of writing
drew me into its spell completely. I was actually able to prepare and anticipate the orga-
nization of words, paragraphs, headings, and footnotes before I arrived at the machine. I
would have worked out much of how I was going to structure and tabulate something before
I began the act of typing of it. I was used to this kind of thinking from having learned to
write with a typewriter and having to understand the density of text from typeface to line
spacing and indenting. This new writing system had only one drawback to it, which to this
day still tugs at my nervous system. It was the irrelevance of the paper itself.

Not that I was immediately convinced of the paper-less office or any kind of transition
away from the printed word. But—while engaged with the process of placing words and
thoughts into the byte-stream of memory chips and having those same bytes rendered on
magnetic substrates—it was difficult to set aside the actual paper on which these words
would eventually be inscribed. At this time, the appearance of a laser-guided imaging
system allowed for a remarkably faithful reproduction of the text, nearly indistinguishable
from an offset press image.

Any kind of failure on these new writing systems was almost always catastrophic. When
you are typing something, you can make errors or rewrite an entire page to allow for a new
paragraph or change to a sentence. One did not always expect to start writing from the
first page if one accidentally dropped a clutch of pages in the wind. But if your magnetic
recording is fouled up in all manner of possible flaws and interferences, you will have nothing.

The whole notion of having other copies of what you were writing is a conceptual leap
which every digital writer has had to make. Although not that difficult to adjust to,
the requirement is a bold statement regarding the fragility of data and the reliance on
technological innovation to increase reliability—as well as provide meaningful reduction in
risk. This new level of risk emerges from the process; like turning to find a mother bison
coming at you in full gallop. The sudden realization and blood curdling panic which races
up your spine when you are met with the inexplicable error message regarding your hours
of keyboarding not being found on this disk is a kind of terraforming of the brain from
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which you will never return. It is the night terror of this new virtual writing where it could
all vanish in a misplaced keystroke.

But learning is all about mistakes.

Everyone who is eventually introduced to this new world of text construction takes this
lesson in a different way, keeps a different tale of woe, and registers a new found respect for
the fleeting finality of formatting a disk.

The green on the screen falls deeply into the subconscious whenever one is immersed in
their fantasy world of storytelling. In time our eyes acclimatize to the contrast and the ever
halting progress of the cursor block as all your words appear as if revealed, character by
character, from the deep black of the surrounding void. The compressed descenders of the
modified typeface to accommodate the word-space of each line produces an altered state of
awareness that these representations of the text are only a reasonable facsimile of the final
work. These blocks of green (spaced and aligned) can only suggest what will end up on the
printed page. Just as one who types onto the roller is only able to offer up a reference work
for the typesetter’s eye, so too, the green screen of those early computers found a tolerant
mind ready to accept their limitations if the relationship could flourish and the outcomes
were as satisfying as before.

For as long as these early months lasted and the “pure text” experience of the keyboard
and screen helped me produce useful results, I was ready, willing, and able to acquire the
new knowledge necessary to make it perform for me. My needs were simple and my skills
were quickly reaching mastery in this entirely word-process activity. This was progress and
this was useful. This was helpful and had increasing efficiencies, which moved my work and
my career forward. My output on the green screen was considerably higher by volume, but
to this day I have still to evaluate the results in terms of quality.

All manner of work-related activities were quickly subsumed by the leverage of a screen
and keyboard. What was once the province of computer analysts in air-tight rooms with
elevated floors, massive iron, and cryptic conversations seemed to be arriving on people’s
desks daily for use in their everyday activities. That so much time and workplace effort
was redirected toward learning to shape your work to fit the demands of the keyboard has
been the subject of perhaps not just a few investigations.

When once the efficiency expert strutted the halls of industry with clipboard and stopwatch,
now the computer consultant motored into offices to declare a new world of calculated effort
and higher productivity. These same enthusiasts for these new systems were conveniently
blind to the lost productivity of hardware failures, network bottlenecking, and the dreaded
blue screen of death. Everywhere I turned, by the time I left that employment, eyes were
fixed on screens, hands clutched plastic mice, and printers shoveled whole volumes of text
into that world. The transformation of work was well underway when the next concept in
computing arrived to bring visual metaphors and iconography to the screen.

Having already established a solid beachhead of skills in desktop publishing using a
keyboard-driven paradigm, I was most taken by my first exposure to the virtual desktop.
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It was love at first sight. I can admit that now. After decades of therapeutic struggle
and countless millions of keystrokes, I can today admit that the appeal and sensibility of
what I saw struck me immediately as the most innovative and appropriate redesign of the
computing experience I could ever have hoped for.

Within weeks, new eye-hand coordination skills were established. Faster and more compre-
hensive style management was appropriated. Document management and duplication were
simplified. A graphical environment supported and surrounded the text. The objectification
of filing and storing, retrieval and transfer was the most natural of evolutions in this new
working virtual space. The capability which sealed the relationship was the WYSIWYG
display and accuracy of the layout and typefaces. It was at once the most complete writing
environment anyone could have imagined for me and an implementation of a supporting
structure to ensure my text was always handled in the clear light of day.

And, for all this, I traded in my subliminal relationship with green text on a black back-
ground. I no longer had to maintain a mental image of what the text would become. I could
make choices, adjustments, and decisions, more accurately based on what was rendered on
the screen. With black text on a white background I had moved from an abstraction of the
process to a visualization of the process.

When I finally was able to commit personal funds to the acquisition of such a system, I was
entering into a permanent and unrelenting relationship with an emerging technology, which
was about to change the way everything is done, the way people relate to each other, and
the way people would begin to adjust their perceptions of themselves.

Computers had moved from the power of the words to the power of the image. Nothing
would ever be the same again.

Written using WriteRoom in full-screen mode on a MacBook Pro. This program is an
interesting throwback to a time when typing was the most useful thing a person could do
with a computer.

Copyright © 2011 Dave Trautman. Dave is a Media Specialist working in Canada, with a special
background in Media Effects, who has been using a Macintosh computer since 1988. The Segments
section is open to anyone. If you have something interesting to say about life with your Mac, write us.

)
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Desktop Pictures

Henk-Jan Osse, obc@xs4all.nl

The Netherlands

We need new desktop pictures each month. Write to us!

This Month’s Desktop Pictures
This month’s photos were contributed by ATPM reader Henk-Jan Osse:

The pictures have been taken in The Netherlands (or Holland), in the northern
provinces of Friesland and Groningen, during a summer sailing vacation. It is
an area not very densely populated, some old picturesque villages and cities and
fantastic landscapes. Especially the Waddenzee (Wadden Sea) is a beautiful
part formed of tidal mud flats, wetlands, tidal stretches, and some islands like
Texel, Vlieland, and Terschelling. Everything is changing continuously in the
Waddenzee due to strong currents, storms, and also by human interaction. Large
parts of the Waddenzee (including German parts) have been inscribed on the
UNESCQO’s World Heritage List.

The pictures have been taken in Harlingen, a little city on the coast of the
Waddenzee, at the islands Vlieland and Terschelling, and along the waterways
from Harlingen to Lauwersoog.

Enjoy!

View Pictures

Contributing Your Own Desktop Pictures
If you have a picture, whether a small series or just one fabulous or funny shot, please send
it to editor@atpm.com and we’ll consider publishing it in next month’s issue.

Previous Months’ Desktop Pictures
Pictures from previous months are listed in the desktop pictures archives.
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Downloading All the Pictures at Once
Some browsers can download an entire set of desktop pictures at once.

Safari Create a workflow in Automator with these three actions:

1. Get Current Webpage from Safari.

2. Get Image URLs from Webpage. Get URLs of images linked from these
webpages.

3. Download URLs.

iCab Use the Download command to “Download all linked files in same folder” and con-
figure the limits to download only the linked images.

OmniWeb Choose “Save Linked > Images...” from the File menu.

Placing Desktop Pictures

Mac OS X 10.3.x Through 10.7.x
Choose “System Preferences. ..” from the Apple menu, click the “Desktop & Screen Saver”

button, then choose the Desktop tab. In the left-side menu, select the desktop pictures
folder you want to use.

You can also use the pictures with Mac OS X’s built-in screen saver. Select the Screen
Saver tab which is also in the “Desktop & Screen Saver” System Preferences pane. If you
put the ATPM pictures in your Pictures folder, click on the Pictures Folder in the list of
screen savers. Otherwise, click Choose Folder to tell the screen saver which pictures to use.

Mac OS X 10.1.x and 10.2.x
Choose “System Preferences. ..” from the Apple menu and click the Desktop button. With

the pop-up menu, select the desktop pictures folder you want to use.

You can also use the pictures with Mac OS X’s built-in screen saver. Choose “System
Preferences. ..” from the Apple menu. Click the Screen Saver (10.1.x) or Screen Effects
(10.2.x) button. Then click on Custom Slide Show in the list of screen savers. If you put
the ATPM pictures in your Pictures folder, you're all set. Otherwise, click Configure to tell
the screen saver which pictures to use.

Mac OS X 10.0.x
Switch to the Finder. Choose “Preferences...” from the “Finder” menu. Click on the

“Select Picture...” button on the right. In the Open Panel, select the desktop picture you
want to use. The panel defaults to your ~/Library/Desktop Pictures folder. Close the
“Finder Preferences” window when you are done.

)
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Out at Five

by Matt Johnson, mjohnson@atpm.com

The New Auditor
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Service With a Smile
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A Big Mess
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Copyright © 2011 Matt Johnson.
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Qaptain Qwerty

by Linus Ly, http://qaptainqwerty.blogspot.com

An Apple a Day

IS 4.0 REALLY 3 ' " ;
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PHONE IS STILL ON Joey 5 is healthier for
G- :

youlll

RAPTAINGWEETY

Copyright © 2011 Linus Ly.
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The Spinning Beachball

by Grant Osborne, http://grantosborne.com

Tue SrivninG Beacwpall

Copyright © 2011 Grant Osborne.
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Software Review

by Linus Ly, lly@atpm.com

Comic Life 2.0.6

Function: Makes comic-book styled presentations.
Developer: plasq

Price: $30; $10 (upgrade)

Requirements: Mac OS X 10.4. Universal.

Trial: Fully-featured (30 days, then watermarks) VERY NICE

I have an on-and-off relationship with Comic Life. Way back when it first came out, I
bought a boxed version of it from Amazon. I recall that the plasq Web site directed me to
Amazon and mentioned that it was cheaper than buying directly from plasq. Years later
I reviewed Comic Life Magiq in ATPM. Now Comic Life 2 is out, and I have been using it
for the past few weeks.

New and Improved

For users of the original Comic Life, the first noticeable difference with Comic Life 2 is the
templates window. You are prompted to choose one of the new templates every time you
start the program. Comic Life 2 is advertised as more than a tool to make comic books,
and the templates support that claim.
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Built-in: Blank
Bullt-in; Creative
Built-in: Education
Built-in: How To
Built=in: Lifie Stories

" ——

Open an Existing File... | Ciose _Jfl _select |

The Template Chooser welcomes you to Comic Life 2.

Templates have categories such as Creative, Education, How To, and Life Stories. The
various templates within the categories have graphic elements or settings that match the
template names, e.g. flower-shaped frames for the Spring template or a scroll-shaped frame
for the Ancient History template. Road Trip is one of my favorite templates. It has a road
map as a background, with titles in gradient chrome colors suggestive of cool cars—just the
thing to hide the fact that your trip was done in an unsexy family minivan.
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The Road Trip template may be more interesting than the actual trip.

Another template I like is the Yearbook. I have been busy getting in touch with high school
friends and often refer to my yearbook. The template Comic Life 2 has is very much like
my year, 1985. Most frames are small for the grads’ headshots, then there are bigger ones
for candid photos or perhaps some popular students or events.

Templates are not new to Comic Life 2, but thematic ones like those presented at launch
are. The old templates are just a bunch of rectangles of various sizes. The new thematic
templates include stylized text, frames of various shapes, and many graphic elements. I just
wish these new templates were available for choosing in the same location alongside the old
ones. In case you do not like to see the Template Chooser at launch, it can be disabled in
the Preferences window.

Once in the program, you will notice the new Inspector window. A popular element in
many of today’s Mac applications, the Inspector is a floating window from which you can
make adjustments to your work. The various settings are grouped into tabs to minimize
the real estate the Inspector occupies, but I still find it obtrusive. Luckily, many of the
actions you can carry out via the Inspector can be done through some other window or bar
of the Comic Life 2 interface, so you do not have to have the Inspector visible all the time.
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Should you really love the Inspector, you can have multiple windows opened, perhaps one
for image adjustment and another for tweaking text.

As someone who is fond of fonts, a short time spent with Comic Life 2 is all I need to notice
the WYSIWYG font selection gadget on the new format bar. With the older version, to
select a font, you needed to bring up the Fonts panel and temporarily lose a large chunk of
the screen. Now, just a click on the format bar, and you can see all the fun fonts that come
with Comic Life 2, all in their individual stylish appearances. And there are more fonts,
too. Comic Life 1.x had two versions, a regular one and a Deluxe one, the difference being
the number of fonts, styles, and templates. With Comic Life 2, all the Deluxe elements are
included.
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You can work with one or many Inspector windows. And look, what-you-see-is-what-you-get font preview!

But Wait, There Is More

More than once, while using Comic Life 1.x, I wished there were a way to have more than
one picture in a panel. With Comic Life 2, my wish was granted. As you drop a second
picture into a panel that already has a picture, you are asked if you want to replace the
first picture or add to it.

There is not much image-processing you can do to the pictures once they are placed in the
same panels, but there are uses for the function. Like all elements on a Comic Life page,
you can re-size and rotate the pictures, even adjust brightness, sharpness, and such; but
do not expect fancy alpha channel blending of the pictures. Comic Life is supposed to be
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easy to use, and having image-processing functions on the level of Photoshop would make
the learning curve steep and the application unenjoyable. A simple collage is all that you
should aim for.

I wanna be in The Marathon, So freaking bad
Run the whole twenby-six point two miles

Three pictures in a panel. No blending or anything fancy, but it gets the job done.

Another welcome, new function is picture-in-bubble. In comic books or cartoons, bubbles
are usually used to give voices to the characters. You also have bubbles to indicate what
the characters are thinking, whispering, or screaming. I once wanted to make a picture that
said, “I am thinking of you”—one person with a thought bubble over his head, with another
person inside the bubble. It was probably impossible to achieve with 1.x, but with Comic
Life 2 it can be done easily. Just place a thought bubble on a page, then drag a picture
onto it. The picture will be masked to appear where the text normally would appear. Since
the picture does not show in the tail portion of the bubble, the tail may look odd, so the
effect is best done with a thought bubble, in which the tail is a series of detached circles
of increasing sizes, running from the person to the bubble. If you have to use the function
with other types of bubbles, maybe you can cut the tail by dragging its tip into the bubble.
I made use of the new function in this month’s Qaptain Qwerty cartoon.

Yet another new and exciting function is Autoflow Images. The standard way to work
with Comic Life is to add panels to a page, then drop photos into the panels. Not that
cumbersome if you have just a handful of photos. But let’s say you are tasked with making
the facebook for some university. (A facebook is a physical directory that shows a photo
of each student at a college, to help the students get to know each other better.) You
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would need to create panels and drop photos repeatedly! Not if you use the new Autoflow
function. Just organize the photos in a Finder folder or an iPhoto album, then select File >
Autoflow Images and everything is done for you. Pages get appended, panels dropped onto
the pages, and then populated with the photos, all with a single click of the mouse.

Small Price of Progress

You can do a lot with Comic Life 2, but it is more interesting when you can share your
work with others. Why, perhaps you were told to upload your handy facebook to Facebook,
the social network. For now, Facebook export is rather rudimentary. You can only export
to a new album, but at least you can control which consecutive pages of your Comic Life 2
work get included.

With MobileMe being phased out and iCloud not quite here yet, Comic Life 2 has no
support for either. The closest to a Web comic is HTML and iWeb. Might as well, I guess,
as most people live in Facebook these days, anyway. Another export option that is gone is
QuickTime. A silent movie is not that much fun to watch, and adding sounds to it is hard
work, so it is no big loss.

All the new functions are great to have, but one side effect, just my guess, is that Comic
Life 2 uses a new file format that is incompatible with the old Comic Life. In my opinion,
it is a small price to pay.

Conclusion

Comic Life 2 brings many new capabilities to the work of making comic pages, or as in the
case of the thematic templates, almost any kind of presentation. The changes I wrote about
are just the noticeable ones and favorites of mine. Others worth mentioning are free-form
shapes and background images. The only quibble I have is that the thematic templates are
available only through the Template Chooser. Comic Life 2 is a very worthwhile upgrade.

Copyright © 2011 Linus Ly. Reviewing in ATPM is open to anyone. If you're interested, write to us at

reviews@atpm.com.
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Software Review

by David Ozab, http://fatherhoodetc.wordpress.com

Memoir 2.0

Function: Journaling.

Developer: Vortimac Software LLC
Price: $8

Requirements: Mac OS X 10.5
Trial: Fully-featured (30 days) VERY NICE

Journal, diary, notebook: call it what you will, but every writer—established, aspiring, or
just-do-it-for-yourself—has to have one. It’s the place where you record private thoughts, jot
down ideas, and capture snippets of dialogue. And while it’s doubtful that any technology
will totally replace a pencil and paper, software-based diaries have been around for years.
Memoir is one such application.

Getting Started: the Calendar

Opening up Memoir, there is a blank area for a new entry and a choice of Organizer or
Calendar view. Let’s start with Calendar view.
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Start Here

Memoir displays the current month with today’s date highlighted—any dates with entries
are highlighted too. I click in the blank area to create an untitled entry, re-title it, press
Return, and start typing. Like all the best apps, getting to the basics is easy. Once done,
I can select a option to add a new entry for the same day, I can lock either entry (more on
encrypting below), or I can delete an entry altogether. Again, no more than what you need
in this view.

Organizing Entries: the Organizer

Calendar view is just one way of seeing entries. Once I've built up a large number of entries,
I'll probably want to organize them by similar subject.
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A New Entry

The default organizer has a set of unfilled entries along with a folder for imported entries.
Now that I'm in Organizer view, I can create a new folder, encrypt a folder, or delete a
folder. Once I create a folder, I name it and then drag the entries I want to include to it.
This lets me file all my entries into categories and easily find what I'm looking for.
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Of course, Memoir also includes a search option in case I forget where I filed an entry.

Beyond Words: Media and Links

So far, Memoir really hasn’t given us anything that a printed book with an index couldn’t
supply—though good luck indexing a handwritten journal. Where Memoir excels is in its
incorporation of media and links. Let’s say I want to add a photo to a journal entry. I've
done something fun today, I've written about it, but now I want to add pictures. Once I've
imported and edited my photos—through iPhoto and Preview for example—I can simply
drag and drop the saved photo right off the desktop into my entry.
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The Apple Logo Is Everywhere

I can drag and drop a video, too, and if the file is large Memoir asks me if I want to add
an alias instead. Then as long as Memoir can access that file it will embed and play right
in the middle of my entry. Audio files can also be dragged and dropped from the desktop
(though not out of the iTunes playlist window).

You can’t write hypertext with a pencil, but you can link to the Internet from Memoir.
Just highlight the link, right-click, and select Make Link. From here, you can paste a URL,
select a file off your hard drive, or select another entry in your journal, turning Memoir into
your own personal “Wiki-diary.”
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A Link to an iPhone Much More Advanced Than Mine

Ins and Outs: Importing, Exporting, Email, and Printing

Import and export are both found under the File Menu. When importing, Memoir uses the
filename as the title and then places the content into the entry field—a logical approach.
Text files, .doc files, and .docx files import as editable text, retaining fonts and formatting.
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Fun With Fonts and Colors

JPEGs and PDFs import as images with the filename as the entry title.

You can export an individual entry (Entry > Export Entry), a folder (Folder > Export
Folder), or your entire journal (File > Export). In each case, you can select file type (plain
text, rich text, rich text with attachments, or Word), and when exporting multiple items
you can preserve the folder structure or create one flat file.
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My Originally Named Folder

To e-mail the text of a selected entry, click the E-mail button on the right of the toolbar.
I checked the settings, and as far as I can tell media and links cannot be included in the
e-mail. Attachments and links can be added to the e-mail, of course, but this is an extra
step that I'd like to see made unnecessary in a future update.

Printing is just as easy, and in this case images print with the text—as do icons representing
embedded media (because we just haven’t figured out how to play a movie on a sheet of

paper yet).

Privacy Please: Encryption

No diary is complete without a secure lock. Memoir features password protection (up to
128-bit encryption) on individual entries and folders, with the option of saving passwords
to the keychain.
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Encryption

It’s up to you to set a strong password, as Memoir doesn’t rate password strength.

Final Thoughts

Memoir is a well-designed, easy-to-use, and inexpensive journaling app. I can see myself
using this software daily for recording ideas, impressions, and rough drafts. There are only
two features I would like to see that are missing. One I mentioned above is the ability to
e-mail a journal entry with attachments and links included. The other—and this is more
for serious writers than hobbyists—is a word count tool. One of the things recommended
to all writers is to maintain a daily word quota. It would be nice to have that option in
Memoir, rather than having to export my entries to Word.

Copyright © 2011 David Ozab. Reviewing in ATPM is open to anyone. If you're interested, write to us

at reviews@atpm.com.
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FAQ: Frequently Asked Questions

What Is ATPM?

About This Particular Macintosh (ATPM) is, among other things, a monthly Internet mag-
azine or “e-zine.” ATPM was created to celebrate the personal computing experience. For
us this means the most personal of all personal computers—the Apple Macintosh. About
This Particular Macintosh is intended to be about your Macintosh, our Macintoshes, and
the creative, personal ideas and experiences of everyone who uses a Mac. We hope that we
will continue to be faithful to our mission.

Are You Looking for New Staff Members?

ATPM is looking to add more regular reviewers to our staff. Though all positions with About
This Particular Macintosh are volunteer, reviewing is a great way to share your product
knowledge and experience with fellow members of the Macintosh community. If you're
interested, contact ATPM’s Reviews Editor, Paul Fatula.

How Can | Subscribe to ATPM?
Visit the subscriptions page.

Which Format Is Best for Me?

o The Online Webzine edition is for people who want to view ATPM in their Web
browser, while connected to the Internet. It provides sharp text, lots of navigation
options, and live links to ATPM back issues and other Web pages.

o The Offline Webzine is an HTML version of ATPM that is formatted for viewing
offline and made available in a Mac OS X disk image. The graphics, content, and
navigation elements are the same as with the Online Webzine, but you can view it
without being connected to the Internet. It requires a Web browser.

o The Print PDF edition is saved in Adobe PDF format. It has a two-column layout
with smaller text and higher-resolution graphics that are optimized for printing. It
may be viewed online in a browser, or downloaded and viewed in Apple’s Preview or
Adobe Reader on Macintosh or Windows. PDFs may be magnified to any size and
searched with ease.

e The Screen PDF edition is also saved in Adobe PDF format. It’s a one-column
layout with larger text that’s optimized for reading on-screen.

How Can | Submit Cover Art?

We enjoy the opportunity to display new, original cover art every month. We're also very
proud of the people who have come forward to offer us cover art for each issue. If you're a
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Macintosh artist and interested in preparing a cover for ATPM, please e-mail us. The way
the process works is pretty simple. As soon as we have a topic or theme for the upcoming
issue we let you know about it. Then, it’s up to you. We do not pay for cover art but
we are an international publication with a broad readership and we give appropriate credit
alongside your work. There’s space for an e-mail address and a Web page URL, too. Write
to editor@atpm.com for more information.

How Can | Send a Letter to the Editor?

Got a comment about an article that you read in ATPM? Is there something you’d like
us to write about in a future issue? We'd love to hear from you. Send your e-mail to
editor@atpm.com. We often publish the e-mail that comes our way.

How Can | Contribute to ATPM?

There are several sections of ATPM to which readers frequently contribute:

Segments: Slices from the Macintosh Life

This is one of our most successful spaces and one of our favorite places. We think of
it as kind of the ATPM “guest room.” This is where we will publish that sentimental
Macintosh story that you promised yourself you would one day write. It’s that special place
in ATPM that’s specifically designated for your stories. We’d really like to hear from you.
Several Segments contributors have gone on to become ATPM columnists. Send your stuff
to editor@atpm.com.

Hardware and Software Reviews

ATPM publishes hardware and software reviews. However, we do things in a rather unique
way. Techno-jargon can be useful to engineers but is not always a help to most Mac users.
We like reviews that inform our readers about how a particular piece of hardware or software
will help their Macintosh lives. We want them to know what works, how it may help them
in their work, and how strongly we recommend it. Please contact our reviews editor, before
you begin writing, if you have a piece of hardware or software that you’d like to review.

Which Products Have You Reviewed?
Check our reviews index for the complete list.

What is Your Rating Scale?

ATPM uses the following ratings (in order from best to worst): Excellent, Very Nice, Good,
Okay, Rotten. Products rated Good or better are ones that we recommend. Okay products
get the job done. We recommend avoiding Rotten products.

Will You Review My Product?

If you or your company has a product that you’d like to see reviewed, send a copy
our way. We're always looking for interesting pieces of software to try out. Con-
tact reviews@atpm.com for shipping information. You can send press releases to
news@atpm.com.
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Where Can | Find Back Issues of ATPM?

Back issues of ATPM, dating since April 1995, are available in DOCMaker stand-alone
format and as PDF. In addition, all issues since ATPM 2.05 (May 1996) are available in
HTML format.

What If My Question Isn’t Answered Above?

We hope by now that you've found what you’re looking for (We can’t imagine there’s
something else about ATPM that you’d like to know.). But just in case you've read this
far (We appreciate your tenacity.) and still haven’t found that little piece of information
about ATPM that you came here to find, please feel free to e-mail us at (You guessed it.)
editor@atpm.com.

)
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